DIGIT

AUTUMN 2008 Issue No 39

FROM THE CHAIRMAN

------------------------------

Digital Imaging Group

Committee for 2008/09
See opposite page for
DIGRO contact details.
Chairman: Clive Haynes FRPS
01905 356405
chairman@digit.rps.org

Vice-Chair and
DIGRO Co-ordinator
Chris Haydon
01234 782196
chrishaydon@digit.rps.org

Secretary: Bob Pearson FRPS
01404 841171
secretary@digit.rps.org

Treasurer: Elizabeth Restall LRPS
01453 844389
treas urer@d ;g;ups. org

Publicity and Website:
John Long ARPS
01179 672231
john long@d ;g;ups. org

Exhibitions: Alex Dufty LRPS
01454 778485
exh ibition@digit. rps. org
Maureen Albright ARPS
01672 540754
maureenalbright@digit.rps.org

Tony Healy ARPS
+61 (0) 2 9958 1570
anthonyhealy@digit.rps.org

Graham Whistler FRPS
01329 847944
grahamwhistfer@digit.rps.org

Cesi Jennings LRPS
01275 372200
cesijennings@digiups.org
Dr Barry Senior HonFRPS
Ex officio

01425 471489

Once again it is with pleasure that we're able to
bring to you the content of our Print Exhibition
this year on DVD. Our grateful thanks go to our
colleagues Graham Whistler FRPS and Gordon
Rushton who have made the production
possible.
As many of you know. my response to an image
is reactive and interpretive rather than criterialed. After all pictures. especially those aspiring
towards the artistic genre are meant to be read,
and surely that's one of the reasons why we
take and make pictures in the first place.
What the author intends is not always what is
understood or, shall we say, received by the
viewer but. frankly, that doesn't always matter what is important is that we do a little work,
enjoy ourselves, go on a visual journey, explore
the picture and the associations that it
generates and respond to what we see. There
are no wrong answers.
We hope that you·I1 enjoy viewing the DVD and
that you'll also be able to share it with
colleagues, perhaps at a meeting of a camera
club or photographic society. This is one way in
which we can spread the word about the RPS DI
Group and simultaneously provide an
entertaining evening which is also informative.
Early autumn is the time of year when many
photo clubs begin their season. A regular part of
the programme will be the inevitable diet of club
competitions. Club competitions run from year
to year on fairly traditional lines with a tendency
to perpetuate the same old styles of imagery which tend to encourage a mind-set which
inevitably leads people to submit pictures that
will please the judge. Winning cups and gaining
awards is one thing - indeed for some club
members it's their sole objective. But from time
to time we should stop to consider and ask the
question: Why am I taking pictures to please a
particular judge for a single competition? It's all
very fine having an objective such as winning
but from time to time we should consider its
validity. Why not try something new at your club?
Instead of the time-honoured competition
wl1ere there are distinct winners and losers, why
not organise an 'image appreciation' event,
where a knowledgeable and respected
photographer with the ability to 'read and
interpret pictures· can take time to understand,
appreciate and interpret the meaning and

presidentrps@digit.rps.org

IA'IBT DISTINCTIONS
FOR DI GROUP MEMBERS

DIGIT is the magazine of the RPS
Digita 11 rnaglng Group and is provided
as part of the annual subscription to
the Group. Copyright of the entire
contents is strictly reserved in all
countries and remains with the
authors who have asserted their
intellectual property rights.

We are delighted to congratulate the following
DI Group members who t1ave recently gained
distinctions:
Fellow: Alan Boutet, Bob Pearson
Associate: Peter Gawthrop, Ben Gorman,
Anne Mahany
Licentiate: Brian Collins
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significance of the
images. Alternatively,
invite a panel of three or
four photographers to
give their views and
interpretations.
This
style of event should
encourage
audience
Clive Haynes FRPS
participation and the
Chairman
opportunity for the
author of the work to have an in put and broaden
the discussion. An event such as this, if
supported with a spirit of openness and
adventure, should lead the way to a better
understanding of those stimulating, risk-taking
and non-predictable formulaic images that so
often are not entered into competitions through
fear of failure. Art should be about taking risks
- let's do it, and eventually we'll give the judges,
who expect predictability, something to think
about! And, yes, think is the operative word.
By the time this edition of DIGIT reaches you,
more information will have become ava·11able
about Think Photography 08 at which the RPS
will have a strong presence. The Digital Imaging
Group will be at the event so do get along to the
National Motorcycle Museum. which is close by
the NEC, Birmingham and enjoy both the
exl1ibits by numerous leading photographic
manufacturers and companies and the events
organised by the RPS.
The event takes place over the weekend of 15 16 November, in two exhibition halls with a
trade show. L Panel assessments, advice on
portfolios. lectures and much else.
Tickets are £7.50 in advance £9 at the show so
get in early and join us there.
For more information, visit the RPS website.

Love it or loathe it?
Please let me know.
Well that's what I asked in the summer issue
but it seems the answer may be: Don't really
care! The redesigned DIGIT doesn't seem to
have made much impact judging by the
deafening silence. Tl1e few who did were
pleased wit11 the new style so I'll stay with it.
Jim Buckley LRPS Editor
editor@digit.rps.org
1 Aldenholme
Weybridge
Surrey KT13 OJF UK
DIGIT relies on the contributions of
members. So, when will you send me an
article for DIGIT? Remember that everyone
is learning and that all experience is
valuable. We look forward to hearing from
you. Thank you.
j~IM- lsuc~Lejj LRPS 6ci~toy
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Committee Report for Members
from Secretary Bob Pearson FRPS
Meeting held on 27 May 2008
• Finance The increase of £3 in subscription
had come up spontaneously at the AGM. The
r.hange will be implemented from 1 January
2009 and a reminder will appear in the Autumn
edition of DIGIT. The Group had £7,491 in the
bank, £1,000 more than the same time last
year.
• Website Barry Senior and Maureen Albright
had met OMNI about a new website and OMNI
had agreed to provide an estimate against the
criteria provided by John Long.
The Forum site the Group is now using is hosted
by the RPS, Maureen Albright set it up and it is
totally tree to the Group. The current website
and forum is now a working alternative to the
corrupted site.
It has been made clear to the Committee that
there is no guarantee that the old web-site
would not be hacked again in the future and so
even if the Committee spent £2,000 plus to
resurrect the site. the same thing could happen
again. It was therefore decided to terminate the
old site. The Secretary was asked to write to Bill
Henley to let him know of this decision and to
ask him to close the site with immediate effect.
DIG's representative for contact with OMNI will
be Maureen Albright.
For the current website Maureen Albright, John
Long and Tony Mant from the Society are
administrators and John Long and Jim Buckley
are moderators of the forum.
It was agreed that DIG's final website should be
commercially supported and not rely on one
individual.
• Future DIG Events Steve Caplin (How to Cheat
in Photoshop) was suggested as a keynote
speaker for DIG's contribution to the RPS theme
of The Real Thing.
The Chairman is also investigating the
possibility of a bi-annual RPS Convention at a
hotel or university. with a main lecture area tor

keynote speakers and smaller rooms tor
exhibits/disr.ussions organised by the various

SIGs.
• Group Regional Affairs
Chris Haydon will be producing a Regional
Affairs document for discussion with DIGROs to
cover the following:
Digital Imaging Group
Currently DIGROs operate independently of the
DIG Committee so how can a closer link be
DIGITAL REGIONAL
created?
Should
conference
calls
between
ORGANISERS
DIGROs/Committee be instigated?
Contact the organisers
As the DIG Committee otters a payment to cover listed below for full details
start-up costs even though the DIGRO accounts
are independent, should these account be more
Central Southern
closely linked to the DIG account?
Roger Norton LRPS
To raise DIGRO visibility, should DIGROs be
www.csdigital.co.uk
named formally at the AGM?
cs_dig@tiscali.co.uk
DIGROs to be asked to provide a Calendar of
Events and a list of good speakers in their areas
East Anglia
Vacant
which will be collated into a central database;
Are DIGROs prepared to support a DIGRO page
East Midlands
in DIGIT for events and other announcements?
Bob Rowe ARPS
• Photoshop4Photographers Three were run by
www.rpsdigital-em.org.uk
DIGROs. three were as RPS Regional Events.
bob.rowe10@ntlworld.com
The feed-back was excellent.
• Workshops The Darjeeling trip has sufficient
Midlands
support to proceed.
Clive Haynes FRPS
The series of Workshops at West Dean College
www.midig.org
has now finished and Clive Haynes and Graham
dive@cmfoto.co.uk
Whistler will investigate other venues with more
space for other attractions for other studio
North West
workshops.
Harry Bosworth
• IRIS-25 Maureen Albright reported she had
harrybos@aol.com
received 79 entries for this event with a number
of entries from abroad.
Scotland
• Exhibition 2009 Because of difficulty in
Joe Dodgson ARPS
stewarding and hire cost it was agreed that Bath
gerryewan@gmail.com
would not be used as a venue. Instead, Taunton
Library will be used tor two weeks in June,
Southern
followed by Swindon in July and Smethwick in
Dr Barry Senior FRPS
August.
barry@littlepics.freeserve.co.uk
There is a shortage of northern venues so
South Wales
northern DIGROs will be approached for
Maureen Albright ARPS
support.

www.southwales-dig.rps.org
maureen@maureenalbrightcom
Maureen Albright ARPS presents Bill Henley
with a special hamper as a token of the
thanks and appreciation of the Digital
Imaging Group for all his work as Editor of
DIGIT (1997-2003), inaugurating the
original Ustserver which first enabled
members to exchange views and
information via the web, and producing and
running the high/y popular DIGIT web site
which he developed with his son Jain. Bill
served on the DI Group committee for a
decade from 1997 until 2007.
Photo by Robert Albright FRPS.
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Wessex
Maureen Albright ARPS

www.dig.vessex.rps.org
maureen@maureenalbrightcom

Western
Glenys Taylor ARPS
glenys. taylor@tiscali.co.uk

Yori<slire
Robert Croft LRPS
robert@robertcroft.\'\6nadoo.co.uk
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WEB snE DEVB.OPMENIS
Maureen Albright ARPS reports:
Following the attack on the previous web site by
a hacker and a malicious virus, the site at
www.digit.org.uk was rapidly closed down to
prevent members receiving any virus infection. To
quickly update the membership, the DI Group
page on the main RPS web site was used to
convey information and several new pages were
added there.
Meanwhile I had arranged that the RPS would
host and supply the DI Group with a new domain
www.digit.rps.org and I set about creating a few
simple pages. Members accessing the old web
site were automatically forwarded to the DIG
page on the RPS site so they were informed of
developments.
As I had some experience creating web sites, I
was asked by the committee to attend a meeting
at the Society's offices in Bath with President Dr
Barry Senior Hon FRPS and Omni, the RPS site
developers. We discussed our options for a new
website. A number of ideas were discussed to
create a new DIGIT web site but this would be a
lengthy and expensive undertaking. Based on my
experience of using a variety of web Forums I
suggested to Omni that we could cover the main
requirements of the old DIGIT site by creating a
simple on line Forum. Omni were very helpful and
suggested a free Forum which I downloaded and,
over some time. set up with a variety of
interactive pages for members to contribute
ideas, hold discussions, share information etc.
This was initially tested by the DI Group
committee before the site was opened on 12
May. Since then we have had over 2,000
postings in almost 250 topics. Currently there are
85 members but no doubt more DIG members
will soon join.
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The DI Group area on
the main Society
website showing all your
exhibition images.

How to access the Forum
Go to www.digit.rps.org
click on the welcome
page, and then the large
Forum button. Most of
the informatiOn you need
to get started is in the
Forum
Information
section.
To join
and
post
comments click the
register button (top right)
but remember that the
password you choose for
your personal use is not
the special DI Group
password needed to
access the Images tor
Discussion section. That
is
only
password
available from John
Long. Contact details on
Page 2.

The new DI Group Forum

Anyone can view the main information part of the
Forum but you must join to post any message. In
response to the requests of the previous web site
regular users I created a specific section which is
private and accessible only by DI Group
members. This section is devoted to images for
discussion like the old Folio, plus the monthly
competition. To access this part of the Forum
members must request a special extra password.
This is sent out only to DIG members by John
Long ARPS. Due to the nature of search engines
on the web it has been necessary to allocate the
password request to most parts of images
section. I know it can be very irksome to type the
4

password several times for these sections: Sorry,
but I feel it is a necessary security precaution at
present.
I am now liaising with Omni to obtain a quotation
for a future website. Once we have news it will be
posted on the current site and of course
published in DIGIT.
Meanwhile I hope that DIGROs will add
information about their meetings and
announcements to the new site · pages have
been created for them· and organisers will add
events. and members will access and use the
Forum site as much as possible to keep the
group active. Happy Surfing!
See page 10 for the first winner of re-launched
monthly Folio competition.

GOING THE EXTRA MILE
A request from Mike Birbeck FRPS
For the past four years or so I have been the
member of the RPS Advisory Board with special
responsibilities for members with a disability.
To that end, I instigated the scheme for Groups
and Regions to put the disabled symbol
alongside accessible events and venues, and
encouraged you al l to use it. This has largely
been a success and most of you are using the
scheme. for which I thank you.
After consultation with, and encouragement
from, our President Dr Barry Senior Hon FRPS
and the Council I am about to ask you to go that
little bit further. What would be very much
appreciated would be if you could ask those
who organise field trips etc, to offer at least one
event a year that specifically caters for
physically disadvantaged members. Please
also remember that our membership average
age is increasing, and any such event would
also assist those with age related frailties. I am
not asking for it to be exclusively for disabled
and elderly members, but that you consider
their needs when planning events. Additionally,
I would be more than happy to promote any
such event within the Disabled Photographers'
Society and elsewhere.
It might encourage you to think that your
Group/Region attendances might improve, and
membership of the Society as a whole might
increase if we show that we are a caring body.
Remember, you could be disabled by illness or
accident at any time, and with luck you might
grow old, so it could be in your own interest to
act on this request.
I would appreciate a response to this
memorandum which can be sent to me by
email or to the address below.
Many thanks,
Mike Birbeck FRPS
Advisory Board Member
Devonia, Norton Fitzwarren. Taunton, TA2 6QS
Email: mike@birbeck.demon.co.uk
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MEMBERS' PRINT EXHIBfflON 2008
PICTURES AT AN EXHIBITION
Alex Dufty LRPS, ExhlbltJon Organiser, reports on this year's events
This year the exhibition was mounted at three
venues: Bath in June, Swindon in July and the
Smethwick Photo Soc at Oldbury in August.
As ever. with my small band of helpers - John
Long ARPS, Tony Poole ARPS, Ron Morgan LRPS
and Geoff Hughes LRPS. seen hard at work in the
photos here - I arrived early before the Bath
Library opened to assemble the screens and put
up the prints ready for the opening. The formal
ceremony that evening was distinguished by the
presence of Society President Dr Barry Senior Hon
FRPS and Sir George Pollock Hon FRPS.
It turned out to be a good run for the showing at
the Podium, with a steady flow of members and
the general public. However, as explained in the
Secretary's report on page 3, difficulties with
stewarding at this venue mean this was the final
year at Bath. Taunton will host a week of the
exhibition next year but the Group is always
seeking new venues · and of course that vital
help on the ground at local showings. If you can
assist or have ideas please contact me - details
on page 2.
The exhibition was really enjoyed at Swindon.
and as usual they had a high footfall even
though there were a number of day closures as
a result of industrial action.
The Exhibition is always appreciated at
Smethwick and welcomed by the Photo Society
to whom we are very grateful.
Thoughts for the future? Well, I have had to do
the usual repairs on prints, replacing masking
tape and re-gluing prints. Several months on
display in public galleries is a harsh environment
so do make sure that your prints are properly

Yorkshire DI Group Exhibition

In a new venture the Yorkshire Group held its first
exhibition. Thanks to all of our members who
entered their super work which made a fantastic
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Above: Alex Dufty LRPS with
Society President
Photos by David Britton LRPS
Dr Barry Senior Hon FRPS

prepared and well stuck. And for 2009 we will be
reviewing - and looking for a much closer reading
from members of - the published requirements
for the CD which accompanies your prints. No
more huge layered files, incorrect sizes (too small
or too big) and funny formats please! Preparing
the images in what is now the three different
formats for printing in DIGIT, showing on the
website and for the exhibition DVD is a big task,
which becomes bigger when we have to come
back to members to get hold of the file.
But above a 11, keep those prints coming in. It's not
too early to start planning your entries for 2009!

Next Yorkshire
Meeting:
1000 to 1600 onSunday
23 November 2008 at
Selby Community Centre,
Scott Road, Selby YOB
4BL. Ample free car
parking. Creative Images
with PhotoShop: giving
your Colour & Mono
images the WOW factor!
with Margaret & David
Watson. Tickets £5 DI
Group members, £6
others. Robert Croft
LRPS, page 3 for contact
details.

and very successful print exhibition. We received
praise and excellent comments about the high
standard of our work from over 1,100 people who
visited the exhibition.
Thanks to the Committee and especially Phil
Hack, who was in attendance at the exhibition for
the full seven days and was kept very busy not
only showing visitors around our exhibition but
also showing the visitors into the YPU Exhibition.
Workshops, lectures and demonstrations
organised by Phil and the Holmfirth Camera Club
helped to keep people coming through the doors.
We are now planning a second RPS Yorkshire DI
Members Print Exhibition in 2009. hopefully
again at The North Light Gallery. Huddersfield.

Ann Mahany ARPS writes to thank all who supported Fordingbridge Camera Club's Jubilee celebrations:
It was a spectacular success with 1,725 images sent by 185 photographers from the UK and abroad. Only 25% were
accepted so it made an exhibition of very high standard. If you had a picture accepted you did well! The exhibition was
shown at our 50th birthday party when we met former members, some from the start of the club. Their enthusiasm is
responsible for today's thriving club. All entrants will have a CD of the exhibition; more are available from
geoff@munsey.fsworld.co.uk. Award winners· pictures and acceptances: www.fordingbridgecameraclub.org.uk

RPS
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MalllNII AlbrlgbtARPS
lntematlonal Review of Images with
Soundtrack for Under 25 year olds
It is strange how fate plays a part in our lives. In
2006 I attended a meeting of The Society when
it announced grants for Special Projects. I had
been thinking about organising an event to
encourage young people to show their talents in
the digital field and successfully applied for the
special grant to organise a Digital AV
competition for young people under 25.
Adult Audio Visual competitions have a long
history of creating AVs to a set form for judging.
Since the advent of digital AV competitions most
of these competitions accept only executable
files, making it difficult for Mac users to
participate. I realised t11at many colleges used
Macs with their students and if we were to
encourage the young to take part we would t1ave
to open our minds a little more and accept
differing file formats. Hopefully, in due course,
there will be a Mac version of the software.
I decided that we should set only a few very
simple rules as guidelines, letting t11e young
people's creativity take the lead and discover
what they would produce if we gave them the
chance.
Once the main framework and dates were
established, there lay ahead t11e long and
difficult task of publicity. I t1ad spent several
months
working
with
Google
finding
establishments with photograpt1ic departments
when Vice President Rosemary Wilman ARPS
suggested I use the Society's public relations
company, MAX PR (now PilotMax). I was amazed
how quickly word spread and details appeared
in newspapers, magazines and web sites
worldwide.
We added an extra AV day wit11 useful talks and
tuition and so the initial simple competition
turned into a two day International Festival.
Tl1e dates were carefully planned, around the
sct1ool and college calendars and a panel of
eminent judges was invited. Igor Kokarev, the
creator of Pictures to Exe AV software, travelled
from Kirov, Russia - not t11e easiest journey, as
outlined in t11e middle column - especially to
judge t11e competition. He t1ad been very
supportive of our plans and made free
downloads of PTE available to any young
person, school or college who wished to take
part.
Tt1e other judges were all very experienced AV
workers: Robert Albright FRPS, Chairman of the
RPS AV Distinctions Panel, Richard Brown
FRPS, Peter Coles FRPS (who unfortunately was
not well enougl1 to make the journey to judge on
t11e day), and Gerard Desroches EFIAP of
Luxembourg, another International award
winning AV worker and the creator of the Frencl1
AV Forum web site, Diaporamaforum
wl1icl1
circulated the information among t11e large
French AV community.
6

Jake Pursey receives his
award
from
IRIS
organiser
Maureen Albright ARPS

Maureen reports: Igor
Kokarev made his first
trip outside Russia to
help
judge
the
competition. To apply tor
a visa he had an 18 hour
train journey from Kirov
to Moscow,
staying
overnight before the 18
hours home. When he
and his mother travelled
to the UK they had the 18
hour journey again and
the 5 hours flight to
London. In the UK they
enjoyed visits to London,
Bath and Oxford, and of
course some time in
Wales!

Entries began to arrive by post on CD or by email in a wide range of formats. The sequences
were, as I had expected, not the usual AV work
but they illustrated what young people could
produce and I was pleased that entries came in
from many countries. The ages varied from nine
years old to twenty two. At one stage I did not
think we would receive any entries in the
16 to 24 year old section but eventually six did
arrive.
My biggest disappointment was the lack of
entries from schools and colleges who had
downloaded PTE and planned to take part. We
were able to award the prize for the school with
the largest number of entries, but I had hoped
that there would be more support from colleges
and schools. There were 79 individual entries
in total.
I made tt1e decision not to pre-select the
entries, so that all the children's work would be
shown and each child and young adult would
receive a Certificate of Participation. Having
ignited the spark of enthusiasm and interest. I
felt strongly it was very important that all the
young people should feel their contribution was
valued, and they should all take part.
June 2008 finally arrived. It had been a long two
year journey. I was very anxious about how the
audience would react. Would they expect an
adult-type AV competition? Or would they realise
this was a very new experience, young people
given the freedom to sl1ow wt1at t11ey could
produce wit11 PCs and Macs, using a muct1 wider
variety of software and presentation methods
but all using still images wit11 a soundtrack, the
first tentative steps in a long journey to some
future polished sequences?
Only one of the young entrants, Jake Pursey,
was able to attend judging on t11e day and bot11
his entries were awarded t1ighly commended
prizes. I hope we see lots more work in the
future from all t11e prize winners and also some
of t11e ot11er entrants too.
Tt1e audience did appreciate that the work was
produced by children, and the warm and jovial
atmosphere continued into the evening. when
all those staying for the weekend shared a meal
at t11e local pub in the village. I must admit that
at the end of tt1e first day I felt very drained so it
was good to relax and hear the audience
comments in the evening.

The Judges on the day.
Left to right
Gerard Desroches,
Robert Albright FRPS,
Richard Brown FRPS and
Igor Kokarev
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IRIS-25, AV NEWS AND GOOD PICTURE SYMPOSIUM
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people h8d tmvelled long distances to hear the
judges' lectures about different 8Spects of
Audio Visual production - including Richard
Brown FRPS demonstrating how he had first
become interested in scripts and projecting
images using his Chad Valley Thunderbirds
Give-a-Show Projector as a young boy!
Igor Kokarev gave cl lecture about the
development of his Wnsoft company, the
Pictures to Exe software and a special
demonstr8tion of the newly released PTE 5.5.
Igor then went on to show some of the future
developments of the next version 5.6, which is
still being developed with many new impressive
features.

Richard Brown FRPS
reliving his childtiood

The weekend finished with Iots of positive
comments. ,\.1any hoped that the RPS I RIS-25
would happen again, while I just hoped I would
get lots of sleep and more time to create my
own work. Many of the young entrants had
expressed the wish to take part again. I hope
they will all continue to make sequences.
The 2008 RPS IRIS-25 was able to be held
thanl{s to The Royal Photographic Society. It is
hard to conceive of any other photographic
organisation in the UK willing and able to fund
such an event.
AV makers who are not
members should th ink about who is
safeguarding the future of their hobby.
The future? Well we all know it belongs to the
young.

RPS AUDIO VISUAL NEWS
IRIS Results Summary

East Midlands Audio Visual Day
1000 - 1700 Sunday 26 October 2008

George & Doreen Po/iock
Medal and unc/er 16 prize
wiih Stuc/ent Rf'S membership:
Camille Simon of France. 13.
Une Chambre Extraordinaire
Second: Christopher Wa,e, l3:
Here Come the Girls
Hig/ily Commendeds:
Sam Hi/tofJ. 11; Jake Pursey 13;
Hannah Greenstreet. 14

Narborough Pnrisl1 Centre, N8rborough,
Leicester LE19 2EL
3 miles south of Junction 21 Ml/ M69
Lecturers:Ken Biggs FRPS; Bryan Stubbs
LRPS plus Attenders Sequences
RPS AV/DI Group members £7.50. All others
£10.50 Optional lunch £5.50
Contact:Beth Elston, 01530 224206,
het/J.elston@btinternet.com

Royal Photographic Society

l 8th International AV Festival
1 9th to 21th September 2 008
The Royal Agricultural College
Cirencester

1624 yeais Laura Bmeman, 21:
Waiting For Tomorrow. First
,orize witri RPS Student
m embe rship for 8 year.

www.rps-international-av.co. u k

Medal man
It arrived yesterday, writes Ray Wallace
Thompson ARPS, and sends me a picture to
prove it 1 My request for a mug shot with the

" Digital Opportunities"
~
toll0'.-,1ng I.lie suCOl!'Ss o f tJ\e- pr~\.IS fwt Goo d Picture Syniposi:i l :"le lm.:agrng: Scionce ( ;,(K.lp c,t 1ne i;:.,y.11
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Loc<1tion, University o f Westm inster> Regent Streot1 London
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medal was however declined: It would only be a
decrepit Ancient Briton, Ray replied.
Ray won the PSA Travel Division's 2008 Travelette
Competion but the gold med81 was for winning
last year's Electronic Division's Digital Essay. With
two previous Golds, one for an AV using Stockton
on Tees as a tourist centre and another for top
picture in an Exhibition, Rely is still prone to ask:
Was it all worthwhile?
Diel we bore our
audiences? Well, three gold medals prove
something and at least we shared our pictures.
Contact Ray if you would like to see his
sequences on loan.

TONY HEALY ARPS
·-· ··-·· ..

.

THE LITTLE THINGS IN LIFE

Tony Healy has been Interested In natural history for as long as he can remember. In the beginning,
he says, he was an un-academlc, on-financed, poorly resourced, Impoverished David Attenborough !
The only thing In abundance was enthusiasm. Whether It was flora or fauna or geology It has all
appealed to Tony who has readlly answered questions put to him on various of his Follo
submissions. Apart from the Nature Group, most members wlll not know of these anlmals let alone
have seen them. Some are quite small and need unusual containers in which to photograph them.
There Is, Tony explalns, a great variety of subjects avallable: slugs,worms flat and round, spiders,
corals, crab shells, shrimps, molluscs and even stinging cells, which make Interesting and colourful
altematlves to tradltronal Engllsh scenes. Colour variations In the slugs and flatwonns are amazing
and dear old Mother Nature leaves some Interior decorators for dead! It does take a bit of practice
says Tony but here he shows us how he got to grips with macro marine llfe.
n more than one occasion Sir David
Attenborough has shown us that life
exists in the hottest. the coldest, the
driest. and the wettest places on Earth. It is
fascinating to find how life finds its ecological
niche in these places and what it has to do to
survive. Survive is the operative word here.
When one can find yourself on the menu of
other animals you have to be so distasteful or
toxic that you are left alone, or to be as
inconspicuous as possible. Many animals use
both methods of survival no matter where they
live.
Most people are familiar with the more obvious
forms of nature where the animals start off
about the size of a squirrel but there is a
wondrous world of small life that exists all
around us. One place that caught my attention

0

Above: Colourful sea
slugs (nudibranchs) that
can be found on the sea
shore. Others are below
left and opposite bottom
right whilst more can be
seen at:
http;/jwMV.dM:gal/ery,oony'
Right: Various glassware
and perspex containers
for holding specimens in
position. The red in the
little tall container is
sand from a particular
location in Sydney. It was
very characteristic of the
beach.

Right: A more opaque
flatworm from the Great
Barrier Reef.
Flatworms are almost
unbel/evable in their
colour and patterns

8
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Left: Male Seahorse.
Note the tail of a baby
sticking out of the brood
pouch on its •stomach".
Males carry the eggs and
hatched young.

was the seashore, the area known as the littoral
zone, located between the high tide and low tide
mark. In this relatively small area can be found
a huge biodiversity of marine life. Having found
an extensive rock platform in Sydney I set about
seeing what life existed there. Two groups of
animals that were particularly fascinating for
me were the sea slugs (Nudibranchia) and the
flatworms (Polycladida).
Collecting specimens of these two species and
taking them to the Australian Museum for
identification produced a couple of problems.
Firstly the animals were difficult if not
impossible to preserve and secondly as one
curator said to me. ·we don't have anyone
working on these animals at the moment so the
best idea is to take a photograph of them, leave
a copy with us. and one day someone
specialising in them, will walk in the door and
tell you all about them.· Well that was easier
said than done. These were quite small animals
and up until then my first and most recent close
up picture was taken using my mother's No.2
Folding Brownie camera and a dioptre lens to
photograph a newly hatched chicken, not a
technique that was going to work with
nudibranchs and flatworms. Besides you really
needed colour to do them justice.
These were the days before scuba gear and the
Nikonos underwater camera. which even if they
had been around then I would not have had the
money to buy them. Photography was keeping
me poor as it was. I was forced to look at other
ways to overcome my lack of equipment and
start teaching myself about close up
photography.
The first thing was to get a small aquarium. This
could be used for animals that were a few
inches in size but there was also the need to
confine smaller animals so they could be readily
photographed. Animals like barnacles and
RPS DIGIT Magazine Autumn 2008

anemones would have
to be photographed in
the field in situ while
trying not to
get
swamped by a wave. I
had one camera body
written off that way.
Petri dishes served well
for the flatworms and some nudibranchs but the
smaller animals had to be in a position where
one could photograph their best profiles. There
was also the need for a black background that
could be used over and over and it didn't matter
if it got wet. Shop front glass black tiles filled the
bill nicely.

Right: One thing you
have to do is make sure
you don't get reflected in
the front of the aquarium
glass. The cardboard
prop stops that light
from falling on the front
of the camera.
Below: In photographing
crab shells or carapaces
for identification the
edge of the carapace
has to be parallel to the
focal plane of the
camera. All knobs and
bumps contribute to the
identity of the animal.
This one, taken as an
exercise in lighting, is
65mm long and at the
it
was
time
photographed only one
other rare 100 year old
illustration of it existed
was
first
since it
described together with
a hand painting in 1804.
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Pictures taken for identification purposes have
some special requirements. Some animals
blend in with their backgrounds and are difficult
to see where they start and finish. therefore
scientists prefer a clean outline of the animal
for identification. Black and sandy backgrounds
met most of these requirements. Also in the
case of crabs (Decapods) in photographing the
top (dorsal) view of the crab's shell (carapace)
the edges of the carapace have to be parallel
with the focal plane of the camera.
Digital photography has overcome one of the
great problems with film, that of having to wait
for your slides to come back and see if you
captured what you were after. In the case of
animals that would end up in the Museum, one
had to keep them alive until the slides returned.
Now, thankfully, one knows immediately if there
is a need to re-shoot the subject.
.-.,..
Below: Seaslug. Two websites which show a vast
range of nudibranches and polycladidia are:
http;l/www.,zuser.uni-heide/t,erg,dw-bu6jindex.html and
http;//www.downbelow.co.uk/nudibranch.html
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There are many sites now on the Internet that
display some of these animals, photographed
in their natural habitat with modern
underwater equipment. The brilliant colours,
p,nterns and colour combinations of the
nudibranchs and flatworms should be
inspirations to designers and decorators
everywhere. Most tropical species of tt1ese
animals are more flamboyant tt1an temperate
species but for those who mr.1y think my
proximity to the Great Barrier Reef has r.1llowed
me to capture such subjects, all but that
labelled GBR are from Sydney waters.
Most of my shooting has been on land but to
view one of the most elaborate and bizarre
studios for this work have a look at the video at:
http://ngm.nationalgeographic.com/video/
player?titleID=1531204600
his montage was made up of five
individual images, sometimes used in
part or repeated on other layers. Some
have been previously manipulated using the
methods describe below. while others come
straight from the camerr.1. The images used for
this particular composite were:
• A wooden bridge.
• A pile of bones.
• Plastic bottles and tin cans.
• Undergrowth
• Male standing in mouth of cave
With so many elements to a finished
composite. it is impossible to think back to all
steps taken and I don't keep notes. The
process is variable and evolves as I go and so
most of the information is general.
Here the wooden bridge was used as the base
image/starting point and once opened in
Photoshop,
the
image
layer
named
Background was renamed to make it
editable, important as it allowed me to
layer images beneath as well as above
the start image.
I like to find at least one image that I
can blend in to add texture and I find
images of old rusty metal, rotting wood
or vegetation work well. In this instance
the texture was created by blending in
the bones image and also some
vegetation. I keep a file of interesting
textures especially for this purpose.
I start by layering one image over
another and then in the Layers Palette
drop down menu I may select Multiply,
Overlay or Soft Ligflt etc and will vary
the opacity to suit. I may colourise a
layer so that it is a uniform colour; I may
change saturation levels or even apply
an effect from the Photoshop filters
menu. Sometimes I will move the
position of an image in the layer stack
for differing effects and, if I find a whole
image isn't working layered over

T
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This small pink shrimp was found in a muddy burrow in mangroves
near Sydney in 1972. Scientifically unknown it was given the name
Laomedia healyi. Now tllere's a most interesting name!

Jean Whitewood
took first place
when the Folio
competition reopened on the
new website with
I Walk Alone.
DIGIT asked
Jean to explain
her approach to
the image

another, I will often create a layer mask and
use parts of the image or maybe remove the
layer or replace it.
With the mask selected, I can rub away or paint
back in with the Paintbrush and keep just the
bits that work for me; for example, the figure in
this image was masked from the surrounding
cave and used on the final layer.
I will also move images around on their
separate layers until I am happy with
composition. When I have two or three layers
(at most) that I think are working together, I use
the Flatten Image command in the Layers
Palette; this helps keep working file sizes down.
I use the flattened image as the base for the
next step, which is to repeat the process, one
layer at a time.
I will often fill gaps in an image by cloning in
appropriate sections from other parts of the
image, checking to ensure that they are not
obviously repetitive by maybe
changing opacity, size, orientation,
colour and maybe masking parts
out again.
Once I am happy with the overall
composition I will flatten one last
time. At this point I check for areas
that are particularly dark or light
and use the Dodge or Burn tool,
with a large soft edged brush at 1520% opacity, and brush over as
many times as is necessary to get
the right tone.
Occasionally I may sharpen the
image at this point, no more than
20%, if I think it works. Some
images will have already been
sharpened
in
previous
manipulations before inclusion in
the montage.
It really is a case of trial and error
and seeing what works and what
doesn't - and. of course, making
one final judgement of when to stop.
RPS DIGIT Magazine Autumn 2008

GmA UM LRPS

PROTECT YOUR IMAGES
With the Increasing use of larger Images on websites and the ease of downloadlng
pictures you need to take care that your photographs are not stolen or used
lnapproprlately. Gltta Um LRPS shows us how to create a copyright watennark for your web.
hen uploading images on web it is
useful to add a visible copyright
watermark. Naturally large watermarks
can look distracting but a fairly transparent one
can be placed anywhere on the image and at
any size. For a copyright watermark you first
need to create a new document in Photoshop in
File>New. The size could be. tor instance, 1200
x 1200 pixels at 72 ppi resolution. The screen
grab on the right shows the three next steps.
For the copyright symbol pick Custom Shape
Tool (1) from your Tool Palette. Ensure your
foreground colour is black (hit X + D keys) and
that the Shape Layers radio button is turned on (2).
Locate. from the Shape Picker (3) at the top tool
bar, the copyright symbol then click to activate
the symbol. Hold down the Shift key, click in
your new document and drag the© symbol to
fill the space.
Now you need to add Layer Style effects tor the
symbol. Following the screen grab alongside,
from Layer menu pick Layer Style>Bevel &
Emboss (1) or use the tx icon (red circle on
screen grab) at the bottom of the Layers Palette
to open the Layer Style Bevel & Emboss
dialogue box. Emboss the symbol at
Structure>Size by 15 - 20 pixels. Then click at
the top of the Layer Style list (2) Blending
Options and in Advanced Blending drag the Fill
Opacity slider all the way down to 0%. This will
give you a transparent embossed effect.
Next delete the white background layer on the
Layers Palette as your watermark needs to
remain transparent and save it as a tiff or psd
file.
If you wish to add your name on the watermark
create a new text layer with Text Tool and ensure
the Text Layer is above your watermark on the
Layers Palette. Pick a suitable font and add
suitable Layer Style effects as above for the
watermark. Then merge the two layers - go to
Layer>Merge Visible.
You can use the same method to create a
copyright text file with your name, that is: ©Gitta
Lim. This screengrab on the right shows the text
file details. Pick the Text Tool (1) then a suitable
font (2) and font size (3) and type© followed by
your name. To type @ ensure your keyboard
Num Lock is on and while holding down Alt key
use the right hand-side numeric keypad and hit
184. Works with most fonts. Personal Message
me through the Dig website www.digit.rps.org if
you need instructions tor a laptop as the
method is slightly different. To finish it add
effects according to the above watermark Layer
Style instructions.

Right: Contra Jour
Cordyline with subtle
copyright.

W
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Finally to add the copyright
watermark on your image open
the file you created above and
drag the copyright layer onto your
image file. Ensure it will end up
as the topmost layer on the
Layers Palette. To resize the
watermark
go
to
Edit>Transtorm>Scale
and
holding down the Shift Key drag
from a corner to a suitable size;
and drag it to a correct position
on your image. You may need to
adjust the layer opacity to suit
your particular image. Activate
your watermark layer on the
Layers Palette and go to Opacity
and move the slider down from
100% until your copyright
watermark
looks
suitably
transparent.

••
_,
•·.

Right: Poppy in the wind
with copyright symbol.
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CUFF MARSH LRPS

AUTOMANIA POSTERS
With an Lpanel composed of mono shots of early Amertcan cars which DIGIT featured In the spring
Issue of 2006, H's not too much of a surprise to learn that Cllff Marsh LRPS also has quite a passion
for car posters. And, yes, they are of course gleamlng American cars
y main interest in photography is cars,
and in particular early American cars. I
have many hundreds of car images. so
I set about designing my very own first poster.
This proved much more difficult than I imagined,
with my limited Photoshop skills.
I began with a blank canvas and chose a
suitable image to begin as shown below and cut

M

out my first car. Th is is most time consuming and
I have to say, I don't think I would have even
attempted it without my Wacom pad, as this
makes selections so much easier. Nevertheless
it still takes forever to do using the pen tool, very
slowly going round each section at over 100%
magnification and checking to make certain I
have not missed anything (l have to admit I
made a few mistakes here) and then going back
and forth time and time again. Finally my
selection was complete and it was ready to be
put onto my clean canvas. I laid on a background
colour to the canvas and then. using the move
tool, I was able to position the car in the correct
place on the canvas.

This was my first attempt (left) but I was not at
all happy with this set-up and decided to scrap it
and start all over again, repeating the above
procedure. This time I flipped the car image and
included an image of a pretty girl that I had
taken at a music concert a year before.
I 'posterized' both images
to give then the painted
look. It was now time to
add the text (see right)
after a little trial and more
errors. I now added a little
more
black
to
the
background using the
airbrush tool at a low
opacity,
just
rapidly
12
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passing over the entire poster from left to right
until I achieved the desired effect.
One thing I must mention is reflections. After I
had almost finished I noti~ed the many
reflections in the shiny car paintwork so I had to
remove all of these using the clone tool and the
healing brush tool. I used these two more than
anything else throughout the making of these
posters.
After I had completed the first poster I felt rnore
confident to tackle the second as I had learned
so much over a space of about four weekends. If
nothing else, I have taught myself new Photoshop
skills just by attempting new things and I feel a
whole lot more confident for it. As we all know,
Photoshop is truly a wonderful tool, it's just
understanding it!!
I had both poster's printed at 30 x 20 inches and
framed and they now hang in my photo room.
That sounds very posh but in fact it's my
converted garage. Well how many of us actually
put a car in the garage? Maybe I would if I could
afford a classic car!!

TALLAHASSEE
CONCOURS D. ELEGANCE
JUNE 26 · 28

Duesenburg
Right: Hispano Suiza
Cliff took these shots
when he visited the
2008 Amelia Island
Concourse d'Elegance
show in Florida.

RPS DIGIT
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DRPEl'ERGAWIHROPARPS

LANDSCAPE PERSPECTIVES
In less than four years since Joining the Society, Peter Gawthrop has moved rapidly through L to
Associate this year with his speclal brand of panoramic Images. Here Peter describes his route to
a successful ARPS Vlsual Art panel. The panel can be viewed onllne at www.llghtspacewater.net

The succesful
Associateship Panel
One of the Tunnel

images

14

joined the RPS in December 2004 and
achieved an LRPS in July 2005. This gave me
the confidence to develop my own
photographic style. At this time. I had the vague
idea that I wanted to produce images that gave

I

the feeling of being inside the landscape. I was
frustrated that my photographs gave the
impression of viewing the landscape though a
window, through a letterbox or though a
telescope. Early on, I decided that the way
forward was to expand
the camera field of view
by stitching together
multiple images. I tried
various approaches, and
by 2006 has settled on
equipment (Canon 5D
with 15mm fisheye lens)
and Hugin software hugin.sf.net.
The
techniques
are
described in detail in my
article in the Autumn
2007 number of DIGIT.
I also decided that it was
about time I learned
more about photography
and so signed up for a
correspondence course
Art of Photography at the
Open College of the Arts
which I completed last
year.
I
would
recommend this course

RPS DIGIT Magazrne Autumn 2008

to others who, like me, have not had any formal
photographic training and are not able to attend
a fulltime course.
By the end of 2007, I felt that I had enough
material to put together 15 images and I
submitted on CD to the March Assessment in
Bath - and failed to get my ARPS. However, it is

RPS DIGIT Ma~azine Autumn 2008

at just this point that the support system of the
RPS swings into action. The chairman of the
panel, John Chamberlin FRPS, contacted me and
kindly offered to look at my proposed revised
panel and then put me in touch with a local panel
member Rikki O'Neil FRPS who gave me further
advice and encouragement.

Open College of the Arts
courses can be seen at:
http://www.oca-

uk.carV~photqJaffy/
One of the Hole images
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DR PEIER GAWlllROP ARPS
Finally, I attended a workshop organised by the
RPS Scottish Region in Stirling.
There were three main changes which led to the
final successful panel shown on page 14:
1. I submitted prints in place of the CD;
2. I paid more attention to colour saturation and
tone; and
3. I replaced those images identified as weak
with stronger compositions.
All of these changes were important but I would
emphasise my experience that the CD route is
definitely to be avoided; the main reason being
that, when using a CD, the 15 images are viewed
sequentially as a slide show whereas a print
panel is viewed as one entity. In my case, the
panel has a symmetry in shape and colour which
is lost in a slide show.
Did I achieve what I set out to do? I feel that the
image shown opposite and on the previous pages
(which I have called Tunnel and Hole images
respectively) really do give a feeling of being
inside the landscape.
On the other hand, my experiments with
panoramas also revealed that the opposite - or
outside - view also had artistic possibilities. The
two photographs here have 'Planet' projections.
Planet projections

16
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My final thoughts on this panel are summarised by the following Statement of Intent which was read out at the assessment:
This panel explores the visual possibilities released by discarding conventional perspective in landscape photography. Each
image is composed from 24 photographs taken using a conventional digital camera mounted on a tripod fitted with
panoramic head. The choice of location, time of day and lighting is particularly Important as a photograph is taken in every
direction. I believe that these images provide dramatic alternative perspectives on landscape photography.

RPS DIGIT Magazine Autumn 2008
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BOB PEARSON FRPS

THE EVOLUTION OF AN F PANEL
Bob Pearson, Secretary of lhe DI Group, outllnes his path to his recent successful Fellowshlp nature
panel which he tltled: Wlldllfe of the Galapagos Archlpelago. It was photographed and printed
dlgltally. All the Images from Bob's panel can be seen on his website: bobpearsonphotography.com
And many congratulatlons to Bob on the award of a Bronze In this year's Society lntematlonal Print
Exhibition for his print of a Red Crowned Crane In Japan, as seen on page 289 of the Jou maI.
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he story starts several years ago when I
attended a workshop on panel submission.
My photography is very much split between
what is classed as Visual Art and Nature. I had
taken along what I had expected to be the start
of a Visual Art submission with, as almost an
afterthought, some straight prints I had made
from images taken on the Galapagos Islands.
To my surprise the visual art images were
rapidly passed over and the Galapagos images
greeted enthusiastically being described as
'Pictorial Nature·. The reviewers were not nature
specialists and recommended I discuss the
images with someone who was. The selection of
whom to use as your mentor and guru is clearly
a critical one, as is the decision to use one or
many. The reviewers at the workshop suggested
John Chamberlin FRPS. I knew John and it
proved to be a happy and successful choice and
I must thank John for sharing his expertise, his
time and helpful advice that he gave me. At my
first meeting to discuss my prints I was brought
down to earth with a bump: many many were
rejected as not even approaching the necessary
standard.

T
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Above: The successful
Nature Panel presentation

Right: This Galapagos
Giant
Tortoise
was
photographed in a drying
lake which forms in a
caldera situated about
5 miles inland from the
coast of the island of
San Cristobal. Although
setting off just after
dawn it's past 1000 by
the time of arrival and
the temperature is rising
rapidly. Bob took this
shot with the 12-24 mm
lens with the camera set
up on a ground pod.
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IVly interest in the Galapagos goes back to my
junior school days where I read a shortened
version of the Voyage of the Beagle and
became fascinated with the concept of
Evolution. This isolated island archipelago
became a dream destination and I have now
been fortunate to make several visits. With the
increasing numbers of visitors, the National
Park authority has quite rightly imposed more
and more access restrictions. Unfortunately, the
decrease in access significantly reduces the
opportunity for good wildlife photography. For
example, individual visits to a landing site are
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now restricted to once a fortnight; there is no
opportunity to return to make use of knowledge
gained.
All the images were taken on a Nikon D2x DSLR
with lenses ranging from 12 to 400mm (18 to
600mm 35mm equivalent). I initially used
compressed RAW format but had to· reject
otherwise successful shots because the
compression had lost all highlight detail. Later
images used uncompressed RAW. All images
were developed in Lightroom. I used a WhiBal
card as a colour temperature reference when
taking a series of images but found necessary
adjustment in colour temperature to be small.
On putting the panel together the one area that
was visually unacceptable was the vast
variation in the tone of the sky. A wide-angle
lens tends to produce a more colour saturated
image; the equatorial sky at certain angles
appeared as if fully polarised. The blue
saturation was adjusted during development in
Lightroom.
It is of course the final print of the image that
will be judged. Pre-digital I had always made my
own prints on to Cibachrome and loved the high
gloss that this material produced. It is possible
to get digital files commercially printed on to
what is now called lfrachrome but I rejected this
approach as I wanted full control of the final
image. When I first started digital inkjet printing
dye based prints on high gloss paper produced
a very acceptable result that unfortunately was
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Below: Galapagos Hawk
Punta Tortuga Negra,
Isabella. Nikon D2x ISO 400

200400mm f/4 at 360mm
(540mm equiv)
f/6.3 at 1/640 sec

made pointless by the
instability of the image.
Stable pigment based prints
seemed unable to match the
initial quality of a dye print.
By the time I had started to
think about printing the panel I had moved to an
Epson 2400 pigment printer so I searched the
web for the highest gloss material that I could
find. I discovered Pictorico Photo Gallery Hi
Gloss White Film made by Mitsubishi Imaging in
Japan. I could find no UK supplier and had to
import it from the States. On getting a personal
profile made the profiler reported back that the
material had the highest D-max of any material
they had measured. Tests showed a wonderfully
detailed image of the highest resolution that I
had seen and the profile was perfectly neutral
introducing no colour cast. I always print using
the native resolution of the original capture.
The layout of the panel is clearly critical and
needs to appear well balanced with lighter
images at the top, darker at the bottom, side
prints looking inward and some degree of
symmetry around the centre image. In a general
panel such as this images need to demonstrate
a wide variety in choice of lens and viewpoint
and subjects in non-static poses.
I have included three main images from the
panel. I had been focused on the Galapagos
Hawk sitting on its perch for some 45 minutes.
It was now 1730 with sunset at 1800, the time
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Above: Male Great Frigatebird attracting female to nest. Dan,vin
Bay, Genovesa
Nikon D2x ISO 400. 24-120mm f/3.5-f/5.6 at 24mm (26mm
equivalent) f/8 at 1/1250 sec
Left: Galapagos Penguins courtship
Bartolome, Santiago. Nikon D2x ISO 400. 200-400mm f/4 at
260mm (390mm equivalent) f/8 at 1/2000 sec

we had to be off the beach. At last it left its perch.
The second image (above) was also the result of
seeing the possibility, setting up for the shot and
waiting. The male frigate bird tries to attract a mate
to its nest by this display, inflating its courting
pouch and shaking its wings. A female was
eventually attracted to the nest and I got the shot.
I am very pleased with the shot of the Galapagos
penguins (left) showing human-like behaviour. It
was taken with the 400mm lens, hand held in a
panga (a small inflatable with an outboard motor)
rising and falling some 3 feet in the surf by the
rocks. The black and white penguins were on the
black lava typical of the Galapagos; they had just
mated when the male embraced the female.
I was asked by the RPS if the panel could form the
start of a library of F panels they hope to build for
use as a reference and for display at workshops. I
readily consented. This meant that I had to re-print
the panel for my own use. I found that the original
Pictorico material had been discontinued. its
replacement. PictoricoPro Hi-Gloss White Film, has
proved easier to use as it is thicker and does not
kink so easily.
20
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DR DAVID COOKE LRPS

WEBWISE2
with Dr David Cooke LRPS
As promised in the previous article in the Summer 2008 issue of DIGIT
(No 38), a new topic on the DIGIT Forum has been created. This
currently gives instructions on how to subscribe to podcasts using iTunes as well as the links given
in the previous Webwlse and in this one. If you've looked at any of these, please do make a comment
on the Forum to let me know how useful ( or not) you found them and let me have any suggestions
for future links you'd like to see. You can currently find the Forum at:

http://www.dlglt.rps.org/phpBB-3.0.1/phpBB3/
The Webwlse material is in the DIGIT Magazine area under Webwise. You'll need to register on the
Forum to make comments and to contribute and you can do this by clicking on the Register button
on the top right of the main Forum screen.
his time, I'd like to recommend two
websites and a podcast:

T

Cambridge in colour
http://www.cambridgeincolour.com/
This site. run by Sean McHugh, contains some
excellent low light and night images of
Cambridge, taken whilst he was studying at the
university, together witt1 a number of very good
tutorials covering tt1e basics (cameras and
imaging), tips and techniques (including colour
management) and advanced topics (including
understanding diffraction, camera sensors,
HDR, tilt/shift lenses and photo stitching).
It's well worth a look and hopefully you'll enjoy
the images as well as learning something new
about photography.
Another recommended Website is:
Photoeye http://www.photoeye.com
This is an American site based in Santa Fe.
where there is a bookstore and gallery. The
website has a number of interesting features
including an on-line bookstore but I'm
recommending it mainly for its on-line galleries.
Tt1ese are well worth exploring to see different
types of images that you may find both
interesting and inspiring. These include images
from the current exhibition at the Santa Fe
gallery and a photographers' showcase. Within
tile main gallery there is also a link to the Bistro

which is a sister site containing images from
photographers tt1roughout the world. 'To keep
quality high'. tt1e site states that 'acceptance is
based on a photographer's resume or the
power of their imagery.'

Focus Ring -http://www.photocastnetwork.com/
or subscribe through iTunes
This podcast is a round table discussion
between a varying group of three or four
members of the Photocast Network wt10 all run
their own photography podcasts. It lasts for
about an hour and covers topics chosen by each
of the participants. The discussions are lively
and informative covering the technical and
artistic side of photography as well as
discussing gear. I've found them interesting and
I've learned a lot from them. I think they are well
worth a listen.
Tt1ey are also audio only so you can listen to
them on an MP3 player. You can download MP3
versions of each episode directly from the
Photocast Network site or subscribe using, for
example, ifunes as described in the previous
Webwise and on the DIGIT Forum.
Please let me know if you like the sites I've
recommended here by commenting on the
Forum or by email at d.f.cooke@open.ac.uk and
please do recom rnend sites you've found
interesting yourself so other members can
share thern.

Two further pictures from Bob
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Pearson's F Panel:
Left: Galapagos Sea Lions
Surfing
Right: Land Iguana feeding
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PHIL DRAKE FRPS

FROM WET NOVICE TO DIGrFAL FELLOW
After a long whlle away from photography, rejoining a photo club and dlgltal photograpby rekindled
Phll Drake's enthusiasm and led to a Fellowshlp. Working malnly In monochrome he enjoys the
control posslble with the dlgltal process to produce outstanding prints.

n the early 80s I decided that I would like to
take better holiday snaps. The way to learn
how was by joining a photographic club· that
was what I thought clubs were for. Not knowing
which club to join I luckily came across an
article about a photographic exhibition by
Richmond & Twickenham Photographic Society
(R&TPS). I duly went to the exhibition and was
amazed by what I saw; I didn't realise amateurs
could produce work of such quality. I joined
straightaway and my photographic adventures
started.
To my eyes the best photographer in the club
was Nobby Fry FRPS who was a well respected
photographer. I went to Nobby whenever I
wanted advice and he was a tremendous help;
sadly he is no longer with us.
After two or three years Nobby said I should try
for an ARPS, which I did · who am I to argue
with him! The requirements for an Associate
Panel were different in those days; not quite
sure what they were but Nobby advised me on
what my panel should be. I was mainly into

I
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Toned Monochrome:
Metal

landscapes at that time so that's what over half
of my images were. I should say that I was
purely a monochrome worker and that the
category was Pictorial, now called Visual Art. I
was fortunate enough to be awarded my ARPS
in 1984.
Shortly after this I began losing interest in
photography and at the end of the 80s I left the
club and didn't take another serious
photograph for over twelve years.
It was New Year's Day 2001 and I was in our
local garden centre and I bumped into a
member of R&TPS, we got talking and he
convinced me to re-join the club; he said they
had a digital group, which seemed interesting.
The club was not as big as when I left it but it
still had over a hundred members and in the
twelve years little else had changed.
Digital photography, especially the creation of a
print, fascinated me. I had worked in the
computer industry most of my life so I
considered myself to be computer literate
which helped but I knew nothing of Photoshop.
RPS DIGIT Magazine Autumn 2008

Cobbles

I decided to teach myself, and bought two
books, one by the guru Bruce Fraser of Bruce
RGB fame, and the other by the Greenbergs. I
had retired from work so I decided to devote
one hour a day, gradually working through the
books, to teach myself Photoshop. This never
happened. It wasn't one hour a day: I got so
hooked on it, that I was spending seven hours
a day on it! I am still spending a lot of time (too
much) working with Photoshop, learning all the
time but I don't consider myself an expert. far
from it - in tact I have yet to meet an expert.
Photoshop is such a huge subject that. as
Bruce Fraser says in his book: 'There is nobody
that knows everything about Photoshop, and
that includes the people who wrote it.'
Initially, I stuck with film and scanned the
negatives using a Nikon Coolscan but then
went on to use a Digital SLR abandoning film
forever; I could never go back to the darkroom.
Although I enjoyed my years with the wet
process, the bit I didn't enjoy was setting it all
up and clearing it all away. Now you can work
on the image and when you get tired you simply
save it and continue when you feel like it fantastic! The quality of equipment available
today is unbelievable; there should be no
excuse for work that is technically not up to
scratch. People argue that a digital print is not
up to the standard of the wet process but I
can't see any difference and in fact the control
you have with the digital process makes it
possible, in many cases, to produce better
prints.
My method of working is simple. I Import the
images into Ughtroom, work on the image to
get it as good as I can and then continue in
Photoshop. Lightroom is both a database and a
Raw converter. It is a fantastic tool. similar to
RPS DIGIT Magazine Autumn 2008

Gate

Adobe
Bridge
(a
browser) and Adobe
Camera Raw (ACR) but
you can do more with it.
I am told that there is
somewhere
in
the
region of a hundred L-.;..:;.;...i..:;a
ways to convert a colour image to B&W. I tend
to use only two: Channel Mixer or Grayscale
which is a feature within Lightroom.
As far as manipulation goes I have to confess
that I do take minor things out, like litter on the
street or the odd post. I have nothing against
the highly manipulated image but it's not for
me, probably because I don't have the
imagination!
A golden rule, in photography, is you can do
what you want but don't get caught. A good
example of what I mean is the craze of over
sharpening. I can never be accused of that
because mostly I forget to sharpen at all! In all
the adjustments I do. r try not to go over the top
and therefore make it obvious as to what I've
done. This also applies to the wet process,
where over burning or dodging is obvious.
In my second stint. in photography, my interests
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changed. I no longer take
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mostly landscapes. Now I
tend
to take urban
landscapes, still in B&W.
They tend to be graphical
Images with lines, curves
and shadows but looking
back at my landscapes
they also had the same
features so maybe I
haven't changed that
much.
I didn't actually set out to
get a Fellowship, it
happened following a
lecture given by Roger
Reynolds at the club. I
knew Roger from old. he
was a rnernber of R&TPS
when I was first there and
is an honorary member to
this day. I asked him
during the break 1f he
would look at some of my
pictures to see if they
would be up to the
required standard for a Fellowship. He agreed
and so I took about thirty pictures to his house;
he selected about fifteen as a basis of a panel
and I had to produce another five.
Has digital made me a better photographer?
The upside of digital is that I take and print
many more photographs than I ever did with film
and the old adage is true, the more you practice

-----------------------------=-==~-==-==--_J
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From Phil Drake's F
Panel:
Aove: 21st Centu,y.
Shadows and Light
Below: Wood and Metal

z:>.44,

the better you get. The downside is that you get
careless; I don't think I always put as much
thought into taking a shot as I did with film but
it's something I am working on to try and
correct.
It took nine years for me to lose interest and my
second stint of nine years is corning up soon.
but I feel that this tirne I will still be taking
pictures.
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JOHN LONG ARPS

MAXIMUM EXPOSURE!
SHARING AV SEQUENCES
It's fun to make AV sequences - and even more fun to share them with famlly and friends whether
to keep In touch or to receive the undoubted crltlcal acclalm that you wlll enJoy for your
masterpieces. But that usually means burning a CD and postage since most Internet service
providers do not allow large flles to be sent as attachments. Whllst John Long ARPS, holder of the
Society's prestigious Fenton Medal, has only been Into Audio Vlsual presentations for about two
years, It's no surprise that he has found a neat way of sharing his shows. Of course you can also
send large photo flies In Just the same way. So here's how to get sharing - and It can be free!
o you ever wish you could send an Audio
Visual (AV) sequence or your holiday snaps
to friends. but just can't go to the bother of
creating a CD and mailing it to them? There is a
range of easy solutions: for example, go to
http://digitalvault.bt.com, a BT site where you
can have space to store your photographs or AV
sequences, create albums of pictures from your
recent overseas trips, and share them with
relatives and friends. Originally free there is now
going to be a charge for this site but don't
despair, there are free facilities available like
www.mediafire.com although you have to put up
with adverts.
For BT's Digital Vault click on See how it works
where there are several how to videos to watch.
Some people find the procedure a bit daunting at
first but I am hopeful that by following the steps
below you should be ready to go within a very
short time with this site, or any other.
I am mainly concerned here with audio visual but
all of the details apply equally tor single or
multiple picture albums.
After you've completed the registration process
log in and create and name your first Folder
where your files will be stored. Click on
DOCUMENTS. This will take you to your personal
Vault. Don·t be tempted to click on VIDEOS,
thinking this would be appropriate for AVs.
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To upload a sequence. click on the plus sign(+)
under Actions. The words Add documents will
appear and you will move to the Add Documents
page shown at the top of the next column.
Now put a bullet in Documents from this
computer - click Next and this will take you to
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Upload Files to Document Folder. C1'1ck on Select
Fi/es AT THE BOTTOM OF THE MAIN WINDOW.
,..,o=-- -,...- o=--..-.,....
-,.. ,-. ,"'"'o=-,_,-,..- - - - - - - - , scrolling down if necessary.
This will take you to your own
computer and you can choose
the sequence or files you wish
to upload. Click on UPLOAD
again at the bottom of the

word share will appear and you will move to a
page called Documents as shown below.
Documents
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Type in the email address · here I've used the
Editor's address. You can use the standard email
message which is there, bottom left. for speed or
insert your own. Finally, click on Send invitations
which is at the bottom of the page.
You can also create lists of contacts to whom you
wish to send your sequence by clicking on
Contacts - which is in very small type at the very
top of the page, above View Play Share. Follow
the instructions to set this up then return to the
Documents page, click on your contact's name.
which will have appeared in the box on the right
hand side. If it doesn't appear immediately, use
your Refresh Button.
Several other websites offer the same facilities
without a fee like www.mediafire.com so check
out what's available.
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DR GWYNN ROBINSON FRPS

asks Gwynn Robinson FRPS as he argues that the Image Is everything and urges us
Onward to New Heights - with the New Technologies.
Above:
Grand Canyon - Lytham
St Annes - A new Dawn

Opposite below:
Guardian at the gate to
Heaven and Hell - To
Embrace the New?
Below: New Life - New
Thoughts.
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magine that to capture a photograph all you
had to do was aim a thin screen towards a
scene and snap. It wouldn't matter about the
composition or the focus or the depth of field or
the exposure. All of that would be dealt with on
the PC later on. Yes, every single aspect
including final composition would be done later.
Except for actually turning up, very little
technical or artistic thought would be required.
Could this 'snap and adjust later' approach be
considered photography? Would this satisfy?
Could it be worthwhile? Is it to be embraced or
feared?
In some ways we are well down that track.
Modern cameras of all types help the
photographer far more than in the past. Greater
dynamic range, autofocus. huge sensors, auto
exposure. It may be at present possible to get

I

better results from using manual mode and
knowing what you are doing but the gap in
image quality between auto and manual use is
closing rapidly. New software tools can
recapture focus, sharpen, and all allow easier
manipulation. It won't be long before aspects
like depth of field will be added.
Real artists use paint brushes. It's messy - paint
everywhere, water, thinners, canvasses,
brushes, overalls etc. But what is it that drives
them? Would they create their wonderful
(sometimes) pieces of art if all they had to do
was point their canvass towards a scene and it
somehow magically appeared, but could be
adjusted to suit later? Would that be art?
I have yet to meet an artist who had nothing to
say about their world. Art IS about
communication, expression and passion. It is
also about seeing and vision. Seeing what is
there and vision for what is not.
Some artists have broken free of the traditional
confines of paint. clay, bronze, etc and will use
anything to express themselves. For them the
camera of the future would be a wonderful tool
- freeing them to more easily create what they
can see in their minds.
But of course there is
a danger. If anyone
can capture a ·scene·
so eas'ily so then
everyone will start to
do just that. Worse,
many more will think
that they are artists
and professionals and
bore us all to death. In
an instant things will
RPS DIGIT Magazine Autumn 2008

have changed and the world will become easier to use - buy, thin, apply. In years gone by
flooded with dull, banal, lifeless. soulless. (and not that long ago either) artists would have
worthless. skill-less pictures. Is this good to go and collect soft rocks. crush them. create
an oil or egg emulsion, and apply immediately.
change or bad?
But what of the reverse? Imagine if Beethoven To paint the next day they would have to go and
had never been given access to a piano (high make up some more paint.
tech for their day) or Mozart had never been In times gone past photographers (who were
given access to a violin? What if they had never really
experimentalists)
been given the time and space to practice and would have had to make
learn the skills required? The world would have their own photographic
lost some incredible works of art.
plates and emulsions. The
was
Imagine the countless numbers of people who equipment
cumbersome
and
heavy.
are not technically minded but who are
artistically alive (but perhaps not aware). I They would have had one
believe that everyone is a form of artist. some shot at capturing an image
more expressive than others. Some people are per expensive 'memory
able to communicate. others are not so able. card'/plate. They had to
Some may be stuck because they cannot develop and 'print' the
express themselves using the presently images by hand using some
available tools. Perhaps too much skill (or the pretty
dangerous
wrong type of skill) is required. Given a tool that chemicals. So it was
can allow freedom from the technical minefield expensive. difficult, time
and allow easier expression. such people may consuming and required a
find the door to their creativity opened wide. plethora of skills. Modern
More decent works of art will result.
technology has stripped
But what of the casual painters. photographers. away the need for many of
artists? The ones who are not skilled. not aware the older skills. The skills
and don't care. The ones who snap and click that got in the way of
and use paint by numbers? Well, what of them? expressing
the
artists
If our great new futuristic camera can free them vision. The skills required to simply use the
to enjoy their creativity more. meagre as it might older. more primitive technology. But although
capturing an image has been made far easier.
be, then so much the better.
There is no cure or help for the gadget freaks other skills (like computer skills) are now
amongst us. The ones who just love the required and, far more importantly, the skill of
technical aspects. The ones who need the latest being able to see and vision - the skill of the
equipment and who are not too interested in the artist - remains.
actual images. The ones who love to play and However. listen to the discussions. arguments.
feel and caress the metal, plastic, leather. attitudes in your own photographic society, even
circuits, buttons, screens, etc. They may never in your own mind perhaps. Digital is the death of
delve into the art within them and may never real photographi Digital has flooded society
create or appreciate great images that might with watered down. pointless, brainless. drivel.
Digital cameras have made photography
be. Is it a loss? Perhaps not, if they are happy.
So our hyper-futuristic-camera seems to help all available to anyone and everyone. Modern
sides of our community and increase real works software allows ever more sophisticated post
of art, let alone oil the gears of the economy. So capture changes. The boundaries between pure
why then do we seem to love the technology photography and computer generated imagery
advances and hate what it does for us? We put blurs. I couldn't care less for such thoughts.
down those who use modern technologies to It doesn't matter what equipment or technology
express themselves more easily. It seems a that you use or how much or how little you
complete contradiction of purpose. Is using a change an image on a computer. What matters
digital camera cheating? Does using a digital is what you finally present and that it
camera make me a fake?
communicates your vision. It may require real
Paint and canvasses are easily available now, in skills. vision. thought and definitely technology
any colour or type that you cou Id imagine. Do we of some sort (old or new). But in the end they
decry the old egg based. hard to create and dwindle into insignificance as it is the final
obtain paints? Are artists who use such modern image that counts. It is what you present and
paint technologies to be considered as fakes not how you got there that matters. The image
and their works as worthless? Modern paints will either fade or last, bore or inspire. say
last almost forever. whereas the older paints nothing or touch people. The expression is
lose their colour and adhesion. Modern paints everything. Or as we photographers should say·
have a depth, vibrance and texture. whereas the The image is everything. Onward to New
older paints were weaker. Modern paints are far Heights - with the New Technofog·ies!
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Above: Ghosts Photographers of old

Below: Onwards to New
Heights - with the New
Technologies
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CLIVE HAYNES FRPS
-------

SHOOTING THE INVISIBLE

Chairman Clive Haynes FRPS on going the whole hog with digital IR capture

n common with many photographers in this
digital age, I spent my formative years using
black & white film and darkroom-based
techniques whilst also enjoying parallel activities
with colour transparencies and audio-visual
work.
IVly darkroom-based work caused me to
experiment with infra-red film, notably Kodak
High-Speed IR. I found the medium to be risky,
wayward. constantly exciting and hugely
unpredictable. There was all the business of
loading the camera in the dark (using a changing
bag on location). focussing, then, re-focussing to
the red spot on the lens, fitting the opaque filter
to the lens and guessing the exposure. Then
back in the darkroom the film was processed
using one's preferred developer and, subject to
the usual oddities encountered with IR. a
number of useable negatives resulted. All this
gave a certain mystique to the adventure of
capturing images in IR.
Infra-Red film has been around since about the
1930s - indeed. television pioneer John Logie
Baird carried out experiments with an IR video
system. The movie industry used IR to shoot 'day
for night' to simulate moonlit scenes in black
and white films. IR therefore has a long
pedigree. The scientific community has long
known of its properties for thermal imaging and
'serious photographers· have enjoyed its eerie
and lyrical attributes. especially for landscape
work.
When making the change to a digital camera
system I realised that this was one aspect of
film-based photography that I would indeed
miss.
What is Infra-Red?
More detail is available on the Internet but in
brief, visible light is a small part of the very wide
electro-magnetic spectrum. As the words
suggest, it's the part that human vision is able to
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Abandoned Fann

Making a pre-set
White Balance
Set the camera to
measure
the
White
Balance. In sunlight, point
the camera to a patch of
grass so that it completely
fills
the
viewfinder.
Defocus
the
image.
Measure/set the white
balance (Tip: You may
need to under or over
expose for this test to gain
a setting) Save as a
Custom Setting. Make the
Custom
Setting your
normal White Balance
I prefer to shoot with RAW
files as they offer greater
flexibility and control.
However, if your camera
permits simultaneous jpeg
images to be recorded,
then use the facility as the
standard rendering of the
JR image by jpeg often
gives a pleasing split-tone
result. This is visible both
when inspecting the image
in-<:amera and as a
thumbnail
via
the
computer file-browser and
of course, in Bridge. It
gives a useful indication
about how the image
could appear as a splittuoe without ChannelSv. ..,pping.

detect, and is further broken down into the
spectrum of colours that we can readily identify
from red. through orange and yellow. to green
and so through blue, indigo and violet. Red is at
the low-frequency end with corresponding longer
wavelengths of light and blue at the highfrequency end with shorter wavelengths. Infrared falls in the low-frequency section just beyond
visible red. The wavelengths are measured in
nanometres (nm) and for IR photography we're
looking at something in the region of 700nm
and longer.
When we record the world using IR we reveal
how reflectivity from a variety of surfaces and
objects differs from what we normally expect.
For example, foliage and grasses become
radiant and effervescent in appearance, whilst
blue skies become near black and these special
qualities lend themselves to pictorial expression.
Naturally camera and lens manufacturers
produce products to record visible light; however,
in the good old days there was a recognition by
lens makers that an indicator of the focus point
for IR would be useful and the red dot appeared
on lenses. Look for it on modern lenses and
you'll be disappointed. The red dot was
necessary as IR light, being at a longer
wavelength, focussed beyond the focal-plane of
the camera and the lens required a tweak to
bring the scene back into sharpness.

Digital Cameras
Digital cameras using CCD and CMOS chips are
sensitive to the near infra-red. To avoid
corrupting the image an IR blocking filter is built
into the camera body. The strength of the filter
varies from make to make and model to model.
It's possible to shoot IR on many cameras with
such a filter by using a method similar to film.
It's achieved by fitting an opaque filter and using
a long exposure. Indeed I have done this but it
lacks the speed and spontaneity of straight
shooting. plus there are risks of fogging and flare.

Camera Conversion
I could have sought one of the few IR cameras
available (at a price) which offer direct-viewing
IR. However, I preferred to buy a DSLR camera
and have it converted to dedicated IR use. I
chose the Nikon D70 as both affordable and
readily convertible. Kits are available for DIY
conversion but I sent the body to a specialist,
Advanced Camera Services of Watton, Norfolk
for the task. They were efficient, friendly and
helpful. In addition, the camera is both serviced
and guaranteed. What does the conversion
cost? Presently, around £200. What's also really
useful is that the camera is carefully adjusted in
such a way so that whilst IR is focussed upon the
array, the viewfinder remains sharp. No
refocusing is necessary: you can rely on what
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you see and use auto-focus with no problem. One
of the great things about the converted camera is
me ability to see the IR result immediately after
shooting, check the histogram and feel confident.
White Balance
I found that the key to success is to make a preset white balance for IR. The simple basic
procedure is set out in the centre column on the
facing page. You may need to adapt it for your own
camera.

Channel-Swapping
Tt1is option will frequently give pleasing results
and, as it's simple to do, it's worth using the
option as part of the workflow.
See the centre column
alongside right for the details.
Image Noise
One of the attributes of IR film _ ___
its
gritty,
granular
was
appearance and many considered this to be part
of its attraction. DI IR will tend to be less granular;
however, those seeking a noise-free result are
likely, at the present stage of technology, to be
disappointed. Some noise will be present.
Cameras fitted with large sensors will exhibit less
noise than those with smaller ones at the same
pixel-count. Noise can be reduced by choosing a
low ISO setting and reduced still further by a
noise reduction filter at the RAW stage. Noise can
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Channel Swapping
Open the selected image
and
go
to
Image>
Adjustments >Channel
Mixer. In the Channel Mixer
dialogue box: with the
Output Channel set RED,
change the Red Source
Channel to 0% and set the
Blue Source Channel to
100%
Go to the BLUE Output
Channel and change the
Blue Source Channel to 0%
and set the Red Source
Channel to 100%. Click OK
At this stage the image may
display a range of muted
colours, depending upon the
content of the scene,
Next, go to the image layer,
Image> Adjustments>AutoLevels (Yes, not something
most of us would normally
do I know but have faith; the
purpose is to give a really
useful boost in contrast.)
Following Auto-Levels, the
result is frequently of a
pleasing
tonal
range,
however, it is, of course,
image-dependent:
for
example a scene including a
blue sky and some clouds
where Channel-Swapping
will tend to give a result
which offers a blue-shaded
sky with the remaining areas
represented by tones of
peach, apricot., magenta and
cool slate blues mapped
over the grey-scale content
At this point you can decide
to work with the partially
toned result or convert to
monochrome, apply Curves,
tone, whatever. However for
some images the following
additional tweaks may prove
of service. Try Image>
Adjustments>Auto Colour
lmage>Adjust>Auto
Contrast. The above are
nawrally
content
and
contrast dependent but
sometimes they give that
little extra. And such factors
do inject an element of
serendipity into the process
- just like the old days really!
It's an advantage to make an
Action for the Channel Swap
and Auto-Levels procedure
as this will probably become
the most frequent quickprocess route for pleasing
results for many subjects.
Should you wish to view the
image without the ChannelSwap then simply switch off
the
Channel
Mixer
Adjustment
Layer_ The
image will now equate to the
jpeg impression refe"ed to
earlier.

also be tackled in Photost1op or by using a
separate noise-reduction program such as Neat
Image. Conversely, for those wishing to emulate
IR film, increase tt1e ISO and, witt1 care,
underexpose slightly so that the image histogram
is pushed a little to compensate during the
workflow by adjusting Levels or Curves.
IR film also displayed a sometimes interesting
(though at other times annoying} halation effect
as light bounced off the film pressure-plate. This
can be added to the DI IR image by careful
application of blur and/or glow filters.
Hopefully I have whetted your appetite and that
these few images will indicate the riches that are
out there - awaiting discovery in the invisible
spectrum. And for tt1ose who enjoy an element of
uncertainty in their photography, the serendipity
factor hasn't been entirely eliminated by DI
Camera IR - and something of the excitement the
old days remains.
More information about Advanced Camera
Services
can
be
found
at:
www.advancedcameraservices.co.uk or phone:
01953 889324. My website offers more
information about IR so visit: www.crhfoto.co.uk
and in the next issue of DIGIT 1·11 go into more
detail on channel swapping with examples.

Clockwise:Dark Monolith; Summer Meadow;
Mellte cascade; L/angorse and the Black Mountains;
and Worcester Cathedral
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NEW ZEALAND WRH A NIKON D300
Wendy and Graham Whlstler enjoyed an extended trip to New Zealand at the start of the year
spending January In the North Island and February In the South Island. On the way out from the UK
they also spent two weeks over Christmas In Australla where they spent a day photographing the
dellghts of Sydney with fellow DI committee memberlony Healy ARPS.

The Kingston Flyer
Dr Wendy Whistler
S End of Lake Wakatipu,
S Island. Nikon D70S

The Maui Motor Home
at Mt Cook, South Island
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e flew into Auckland in North Island
New Zealand and picked up our motor
home from Maui. We booked a 4 berth
giving us more room for a two month stay, well
worth the modest extra cost. We hoped the
motor home would give flexibility to see the
country and not tie us down to a series of fixed
hotel bookings. Camp sites were first class and
easy to book ahead. almost on a day by day
basis. We used Top 10 Holiday Parks who have
a great network of good sites all over NZ. All
parks are to a known high standard with fully
contained self-catering units and cabins, to
motor-home and tent sites. January is the main
holiday season so it can be busy with NZ
families. Some sites were busy but there was
plenty of room for all.
Flying out over Christmas means top rates for
air fares. February-March would give savings in
cost and still plenty of good weather. Main roads
are good between major centres and traffic
remarkably low. Remote areas have little or no
traffic and some dirt roads. The motor home

W

has major advantages, with all you need on
board, so wilderness areas are not out of
bounds. Our 2.2 VW diesel powered motor
home was slow on the roads but, with a national
speed limit of 60 mph, was well able to keep up
with the modest traffic. We drove nearly 4000
miles in our two months. Fuel cost compared
with the UK were low and filling up every 400
miles cost about .£25 1 In more remote areas
fuel stops can be over 100 miles apart. Food is
good quality and local with modern
supermarkets in most towns. NZ wine is great:
we drank the odd bottle or two 1
My choice of equipment was easy having used
the Nikon D200 with the amazing 18-?.00mm
lens on my trip to India. Wendy also has Nikon's
18-200mm lens on her Nikon 70S. With the HD
Vl Sony Camera for filming railways I only had
room for one SLR plus lens. The D300 proved to
be a good upgrade from the D?.00. Focusing is
much improved. even in low light. High ISO, even
1000 plus, give remarkably little noise. Most of
the time light was good so 200 ISO was set as
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standard with cloudy white balance. I tend to
work with shutter priority and matrix metering.
After tests I found exposure to be very
consistent but a minus 0.3 exposure factor was
used most of the time. I worry about burnt out
highlights with mountains, lakes and snow but
this proved to be another area of improvement
comparing results from older Nikon DSLRs.
With nearly 1500 RAW NEF images taken on the
trip few needed exposure correction in Nikon
Capture NX. I had my laptop on board so was
able to download images most nights. I also
used a portable 120gig USB mini drive so
backed up all images to that before formatting
my CF cards. The mini drive stayed in my pocket
with my passport while travelling so even if the
laptop was stolen or damaged my images were
safe.
I find the enlarged rear LCD a big improvement
over the D200 but it is still hard to see images
in very bright sun. By keeping the 18-200mm
lens on camera all the time I had no dust
problems and to date still have not tried the
built in cleaner. The D300 build quality is robust
and sealing is of a high order against dust and
water. Even with rain and dirt roads the camera
survived.
New Zealand is famous for its outstanding

scenery, friendly people and uncrowded roads,
with a total population of under 4 million -2.7
million in North Island and less than 1 million in
South Island. We flew into Auckland, picked up
our pre-booked motor home from a site near the
airport and set off to explore. We found the
forest areas amazing with the giant Kauri Trees,
night walks, and even seeing a wild Kiwi. Unlike
Australia there are no poisonous snakes or
animals but watr.h out for midges! The Kauri
gum diggers museum at Matakohe gives a good
insight into the early days of settlement. We
enjoyed the many bays and inlets. 90 Mile
Beach and Cape Reinga in the extreme North
are worth seeing. A day by boat exploring The
Bay of Islands was well worth while.
Further South are the thermal areas but we
thought Rotorua was one of the few places in
New Zealand that was over developed and
packed with tourists. South of Rotorua is the
Central Plateau and volcanic region, including
Mt Ngauruhoe, 'Mt Doom' from the Lord of the
Rings film. Many of the film locations are
marked on the NZ road atlas and there are
plenty all over both islands.
We found Wellington an interesting city and
enjoyed a few days there before our ferry
crossed the Cook Straits to Picton in South
Island. The crossing can be rough but we were
lucky and had a fine day. The long sound into
Picton is beautiful.
South Island has far less people and by
February the school holidays were over so we
often had nearly deserted roads. South Island
also has amazing beaches but is dominated by
the dramatic Southern Alps running from North
to South in the West. The plains to the East are
mainly farming with cattle starting to overtake
sheep farming. We drove to Greymouth in the
West and the rain came in hard 1

Left: Moeraki Boulders
(East Coast S Island)

Above: Mt NgauruhOe,
Central Volcanic Plateau
N Island. In the film Lord
of the Rings this was Mt
Doom.

Mt Cook Region, rain
storms!
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We did the Trans Alpine Rail Trip from
Greymouth to Christchurch and return, a
highlight for my railway filming. It was a rain out
both ways! We saw little of the dramatic views.
Locals said: Great to see the rain; first we've
had for weeks! Rain continued all the way down
the West Coast hiding many of the famous
mountain views and glaciers. Crossing the Alps
via Haast Pass to Wanaka bought much
improved weather.
We had several very rewarding days in
Omarama .but Mt Cook only showed itself from
heavy cloud for two hours. The Fiordland region
in the South West of the island is dramatic and
our trip to Milford Sound gave us some of our
best weather. The Kingston Flyer steam railway
at the South end of lake Wakatipu gave me
some super HD footage that will go in my next
railway DVD - steam and mountains in super
weather with a high speed 'chase the train' in a
laden motor home!
Clean rivers coloured by glacial melt-water flow
in all directions from the alps with some of the
finest trout fishing in the world. South Island is
a dramatic place and the coastal towns in the
east are interesting. The Blue Penguin Colony at
Oamaru with night viewing as they come home
is a great experience. Regrettably no
photography is allowed as flash would upset
them.
There is much to see and do and we think a
month for each island is about right. I could
have done better with my photography since we
were unlucky with the weather some of the time
but it was a super trip and we would go again.
We returned our motor home to Christchurch
and flew home after an eventful and worthwhile
holiday.

Mount Cook, Southern Alps
South Island

Sand Dunes,
North Island near
90mile Beach

Huka Falls near Lake
Taupo, North Island.
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